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Kapitel 1: Erste Schritte in Visual SEM

1.1. Installation

e VisualSfM muss nicht installiert werden und kann zB. von

http://ccwu.me/vsfm/ bezogen werden.

e Mittels VisualSFM wird eine dichte Punktwolke aus Fotos erzeugt, welche im
Anschluss in ein 3D-Modell tiberfiihrt werden kann (siehe Kapitel 2 und 3).

e Der gesamte Ordner ,Visual_SfM_****“ sollte schlicht auf die Festplatte, wenn
moglich auf eine vorhandene SSD (Solid-State-Drive), kopiert werden. Es ist aber
auch moglich VisualSfM von einem USB-Stick, SD-Karte oder Netzwerklaufwerk
zu starten, wovon wir dringend abraten (Verlust von Rechenleistung!).

e Um das Programm leichter starten zu konnen, sollte eine Verkniipfung der
VisualSFM.exe aufz.B. den Desktop oder die Taskleiste erstellt werden.
Hierzu geniigt ein Rechtsklick auf die *.exe-Datei im Ordner ,Visual_SfM_****,
Im nun geodffneten Menii kann dann unter ,Senden an“ -> ,Desktop
(Verkniipfung erstellen)“ rasch eine passende Verkniipfung auf den Desktop

angelegt werden.

[&f Edit with Notepad++

© An Bluetooth senden B Desktop (Verkniipfung erstellen)

§ Freigeben ... 2 Dokumente
Zugriff verwalten ... ¥ Dropbox
Dropbox-Link kopieren _J E-Mail-Empfanger
Auf Dropbox.com ansehen %4 Faxempfanger
Fruhere Versionen anzeigen & InstantBurn CD (S)
Kommentare 45 PDF24 Creator

v/ Norton Security mit Backup » €@ Telegram
An Taskleiste anheften EJ TeXnicCenter
An Startmend anheften "8, WinSCP (zum hochladen)
Vorgéangerversionen wiederherstellen i ZIP-komprimierter Ordner
Senden an » | .8 DVD-RW-Laufwerk (S:)

Ausschneiden

e Per Doppelklick auf die *.exe-Datei oder durch einen Klick auf die Verkniipfung,
startet Visual SfM.

3

SFM - Open Source - Workshop


http://ccwu.me/vsfm/

1.2. Uberblick Programmoberflache Visual SfM (Start)

7 viscasin -0 » -—

File SM View Tools Help
B B2 ooRa I-LEBEF Xewn 04

Modell / Fotofenster

Informationszeile (X-Driicken zur Aktualisierung)

{
g
H

B VisualSEM - 11 -

| File SfM View Tools Help

lea-“ca':lﬁlE&ﬁlqivaﬁlﬁlxnﬁulmﬁ

I O m IV V VIVl vilT X X XI XII XII XIV XV XVIXVI

I.  An-/Ausschalten des Protokoll-Fensters
II. Laden eines fertigen (dichten) Punktwolken-Modells (*.nvm-Datei)
III. Ladenvon mehreren Bildern zur Durchfithrung der SfM-Berechnung
IV.  Speichert die aktuelle Ansicht als u.a. *.jpeg (Screenshot)
V. Kopiert die aktuelle Ansicht (nicht als Bild!)
VI.  Schaltet Bilder / Bildpaare nach links durch
VII.  Schaltet Bilder / Bildpaare nach rechts durch
VIII. 2D-3D- Wechsel
IX.  AufMiniaturansicht umschalten
X. Zoom
XI.  Ansicht wird zuriickgesetzt
XII.  Schaltet Einzel- und Multi-Modelle aus und ein
XIII. Zeigt Verkniipfungen an (2D-Modus)
XIV. Berechnet die Bildposition aller Fotos (rechenintensiv)
XV. Berechnung der diinnen Punktwolke
XVI. Weitere Berechnung der diitnnen Punktwolke (z.B. mit einem zusitzlichen Bild)
XVII.  Stoppt den laufenden Prozess
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1.3.

T

W

1.4.

Schritt 1: Importieren der Fotos

Visual SfM nutzt Fotos im JPEG-Format
Fotos konnen im Reiter: File = Open + Multi-Images oder tiber die Schaltflache
III geladen werden.
Dort sind alle Fotos auszuwibhlen, die zur Modellberechnung verwendet werden
sollten.
o Mit [Strg + A] konnen Sie u.a. alle Daten eines Ordners markieren.
o Mit [Strg] + Linker-Maustaste konnen einzelne Fotos/Dateien wieder
(ab-)gewahlt werden.
Das Importieren der Fotos dauert meist weniger als eine Minute. Im Bereich
der Informationszeile wird iiber Driicken der [X]-Taste auf der Tastatur die
bisherige Rechendauer angezeigt, im Bereich des Protokollfensters wird
~Loading image pixel data ...“ stehen. Je nach Fotomenge und der jeweiligen
Auflosung der Aufnahmen dauert dieser Schritt entsprechend ldnger.
Die Bilder sollten nun als Miniaturansicht im Modell/Fotofensterbereich
erscheinen.
Mittels Rechtsklick kénnen Sie die Bilder markieren (rote Rahmung erscheint).
Doppelklick auf eines der Bilder im Modell/Fotofenster zur Vergrofderung des
jeweiligen Bildes.
o Mit dem Mausrad kann gezoomt werden, Schaltfliche X bietet
vordefinierte Zoomstufen an.
o Es ist moglich die Bilder mit den Knoépfen VI (links) und VII (rechts)
durchzuschalten. Dies dient u.a. zur Kontrolle der Bilder auf Scharfe oder
unerwiinschte Stérungen.

Schritt 2: manuelle Bildpaar-Vorauswahl

Unter Umstanden ist es hilfreich, der eigentlichen V. VisualSFM - [Thumbnails] - (0

Eile |SfM | View Tools Help

Berechnung eine manuelle Bildpaar-Vorauswahl fir Toview s P 47| Qv b WP 1
» ! {

Pairwise Matching

die erste Berechnung voranzustellen e
. . . . . # Reconstruct Resume
Hierfiir kann in der Thumbnail-Ansicht (Vorschau §i ReconstructDense |
. . . . . O Reload All Settings
der Bllder) eine Auswahl von zwel Blldern mit B Load NView Match Start New Model
B . . i . B> Add NView Match
offensichtlich guter Ubereinstimmung getroffen Save NView Match Set Fned Calbration

Clear Workspace BA Bundle Adjustment

werden (mit der rechten Maustaste, entsprechende

Bilder werden rot umrahmt)

Im Menu tber ,SfM“ -> ,More Functions“ -> ,Set Initialization Pair“ kann
entsprechendes Bildpaar als Ausgangspunkt fiir die Berechnung gewahlt werden

5
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e Im Bereich des Protokoll-Fensters werden nun Zahlen zu ,number of putative
matches” und ,number of inlier matches” angezeigt. Umso hoher die Werte dieser
Matches sind, umso besser ist das Bildpaar fiir die Punktwolkenerstellung
geeignet.

e Alternativ, falls die Auswahl von zwei Bildern mit guter Ubereinstimmung nicht
intuitiv getroffen werden kann, kann tiber die Ansicht ,2-View 3D Points“ unter
dem Meniipunkt ,View“ mit den rechts/ links Tasten der Tastatur nach zwei
Bildpaaren mit tibereinstimmenden Punkten gesucht werden

e Diese miissen in der Thumbnail-Ansicht entsprechend ausgewdhlt und als ,Set
Initialization Pair“ gewahlt werden (s.0.)

1.5. Schritt 3: Berechnung der diinnen Punktwolke

e Durch Driicken der Schaltflache XIV (Compute Missing Matches) werden die Bilder
\% verglichen zu ihren Positionen zugeordnet.
o Dieser Prozess benotigt Zeit! Sobald der Prozess abgeschlossen ist,
werden zusatzliche Daten zu den Bildern hinzugefiigt. Diese zusatzlichen
Daten ermdglichen es, bei der ndchsten Verwendung der Bilder den
Rechenschritt (Compute Missing Matches) zu iiberspringen.
e Das Ende des Prozesses kann im Protokoll-Fenster beobachtet werden.
o Protokoll-Fenster: ,Compute Missing Pairwise Matching, finished".
¢ Nun folgt die Berechnung der diitnnen Punktwolke.

e Durch Driicken der Schaltfliche XV (Compute 3D Reconstruction) wird die diinne

% Punktwolke aus den Bildern berechnet. Dieser Schritt ist im Modell/Foto-
fenster zu beobachten. Mittels der rechten Maustaste kann die entstehende
Punktwolke wahrend dieses Prozesses gedreht werden.

e Das Ende des Prozesses konnen Sie im Protokoll-Fenster beobachten.

o Protokoll-Fenster:, Run full 3D reconstruction, finished “

e Durch Driicken der [Strg]-Taste und durch die Betitigung des Mausrades
konnen die Bildvorschaufenster vergrofdert und verkleinert werden.

e Durch Driicken der [Shift]-Taste und durch die Betidtigung des Mausrades
konnen Sie die einzelnen Punkte der Punktwolke vergrofdern und verkleinern.

e Durch einen Rechtsklick auf eines der Bildvorschaufenster wird das jeweilige
Bild markiert. Gleichzeitig leuchten in der Punktwolke die dazugehorigen Punkte
rot auf. Dies dient schlicht zur Kontrolle der Bildqualitat bzw. der Fotoposition.
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1.6. Schritt 4: Berechnung der dichten Punktwolke

Um die dichte Punktwolke zu berechnen wird ein weiteres Programm bendtigt. Das
Programm CMVS ist in der TArchIT-Version von VisualSFM bereits mit im
Programmordner von VisualSFM abgespeichert und muss somit nicht mehr separat
heruntergeladen und dorthin abgespeichert werden.

<M
nz

e Direkt nachdem die diinne Punktwolke berechnet wurde (Schritt 2) konnen Sie die

% nun erweiterte Schaltfliche CMVS auswahlen (links neben Schaltfliche XVII).
e Nach dem Klicken auf CMVS offnet sich ein neues Fenster. Dort muss der
Workspace bzw. der Speicherort der dichten Punktwolke gewihlt werden.
o Es bietet sich an, denselben Speicherort fiir die dichte Punktewolke wie
fiir die Fotos zu wahlen.
o Nachdem der Speicherort gewdhlt wurde, beginnt die aufwendige
Berechnung der dichten Punktwolke.
o ACHTUNG! Dieser Schritt ist ein aufwendiger Rechenprozess!

e Je nach Bildmenge und Rechenleistung kann dieser Schritt sehr lange dauern! Im
Bereich der Informationszeile wird tiber Driicken der [X]-Taste auf der
Tastatur die bisherige Rechendauer angezeigt.

o Im Protokollfenster steht: ,This may take a little more time, waiting...”

e Sollte das Protokollfenster nicht mehr vorhanden sein, kann es entweder iber
einen Klick auf die Schaltflache I oder tiber die Schaltflache ,File=> New
Window* wieder gedffnet werden.

e Das Ende des Prozesses kann im Protokoll-Fenster beobachtet werden.

o Protokoll-Fenster: , Run dense reconstruction, finished “

e Durch betitigen der Tab-Taste konnen Sie nun zwischen der dichten und der der

diinnen Punktwolke hin und her wechseln.

Wichtig: Die dichte Punktewolke ist kein Modell! Sie besteht nur aus Punkten und
muss deshalb in einem weiteren Schritt vernetzt bzw. ,vermesht" werden. Hierzu
wird z.B. Meshlab verwendet. Weiteres zu MeshLab in Kapitel 2.

1.7. Zusammenfassung Workflow VisualSfM

(1) VisualSFM starten.
(2) Bilder laden (Schaltfliache III oder File & Open + Multi-Images).

o Warten bis die Bilder geladen sind.
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(3) Initiales Bildpaar wihlen (zwei Bilder mit guter Ubereinstimmung mittels rechter
Maustaste auswahlen und im Menii SfM -> More Functions -> Set Initialization
Pair)
(4) Driicken der Schaltfliache XIV (Compute Missing Matches).
o Warten bis der Prozess abgeschlossen ist.

(5) Driicken der Schaltflache XV (Compute 3D Reconstruction).
o Warten bis der Prozess abgeschlossen ist.

(6) Driicken auf der nun erweiterten Schaltflache auf CMVS.
o Warten bis der Prozess abgeschlossen ist.

(7) Dichte Punktewolke ist bereit zur Weiterverarbeitung -> weiter mit MeshLab...

<M
=

A=A = =
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Kapitel 2: Erste Schritte in MeshLab 4%

2.1. Installation T

e MeshLab kann tiber z.B. https://sourceforge.net/projects/meshlab/ bezogen
werden.

e Nach der Installation kann MeshLab gestartet werden. Ein Verkniipfungssymbol
sollte bereits automatisch auf den Desktop angelegt worden sein.

e Aufgabe von MeshLab ist es, die aus VisualSFM erstellte dichte Punktwolke zu
»bereinigen“ und aus ihr ein Gitter (engl. mesh) zu erzeugen.

2.2. Uberblick Programmoberfliche MeshLab

o] T P] Bt P IO

& MeshLab_&dbit v1,34BETA - [Project_1]
& File Edit Filters Render View Windows Tools Help

NFwvcesEa @@ w1 8Q

I I Im Iv V VI VIl vilI IX X XI XIO Xl XV XV XVI

I.  Offnen eines neuen Projektes
IL Offnen eines gespeicherten Projektes
IIL. Import eines Gitters / Mesh
IV. Aktualisieren der Anzeige
V. Export des aktuellen Gitters / Mesh
VL Speichert die aktuelle Ansicht u.a. als *.jpeg (Screenshot)
VIL. Offnet die Layer-Anzeige (meist linker Bildschirmrand)
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VIIIL.
IX.

XI.
XIIL
XIII.
XIV.
XV.
XVL

Raster-Modus

Ansicht: Begrenzungsrahmen

Ansicht: Punktwolke

Ansicht: Draht-Gitter

Ansicht: Draht-Gitter mit Flichenanzeige
Ansicht: Gitter/Modell ,kantig“

Ansicht: Gitter/Modell , glatt”

Ansicht: Gitter/Modell mit Textur

Kiinstliche Modellbeleuchtung an / ausschalten

2.3. Laden der VisualSFM-Punktwolken

Zunachst miissen die Projektdaten (NView Match File) aus VisualSFM in
MeshLab geladen werden.

Dazu wird MeshLab geoffnet und iiber Schaltflache II oder tber ,File = Open
project® das Projekt geoffnet. Benotigt werden hierzu zwei Dateien, die
VisualSFM automatisch stets mit derselben Bezeichnung abspeichert.

o Geoffnet werden muss der Speicherort des VisualSFM-Projektes (z.B. der
Ordner Beispiel.nvs.cvms). Dort befindet sich ein Unterordner 00.

o Im Unterordner 00 miissen Sie zundchst die Datei: ,bundle.rd.out”
auswabhlen.

o Danach offnet sich erneut ein Fenster und nun muss die passende
Textdatei , list“ im selben Verzeichnis (Beispiel.nvs.cvims\00\) ausgewahlt
werden.

Nach einiger Zeit erscheint dann im Modellfenster die diinne Punktwolke.

(Bitte abwarten)

Gleichzeitig 6ffnet sich am rechten Bildschirmrand ein neues Ubersichtfenster
(Layer-Anzeige) was mittels VII an und abgeschaltet werden kann.

o In der Layer-Anzeige werden alle Gitter/Punkte etc. des Projektes
angezeigt.

Da das gewiinschte Gitter mittels der dichten Punktwolke zu erstellen ist,
benoétigen Sie die diinne Punktwolke nicht. Mittels Rechtsklick auf , 0 model“
und der Auswahl , delete current match“ konnen Layer geloscht werden.

Als nachstes muss die von CVMS erstellte dichte Punktwolke geladen werden.
Uber Schaltfliche III oder ,File = Import mesh“ bzw. [Strg] + [I] kénnen Sie
diesen Schritt durchfiihren. Die Datei befindet sich dort, wo sie in Kapitel 1.5.
abgespeichert wurde, meistens daher im selben Verzeichnis wie die Diinne
Punktwolke.

Im Unterordner 00 gibt es einen weiteren Unterordner ,models“. Dort befindet
sich die dichte Punktewolke (z.B. option-0000).

10
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2.4. Bereinigung der dichten Punktwolke

Da bei SFM immer wieder ungewiinschte ,,Punktwolken-Artefakte“
auftreten konnen, muss die dichte Punktwolke bereinigt, bzw. Punkte
geloscht werden.
Das Modell bzw. die Punktwolke kann:
o mittels gedriickter linken Maustaste gedreht werden
o mittels Mausrad heran- und herausausgezoomt werden
o mittels driicken des Mausrads kann die Ansicht auf das Modell
verschoben werden.
Zunachst missen Sie die zu l6schenden Punkte mittels der Maus auswahlen.
o Hierzu muss die Schaltfliche ,select vertexes“ betatigt werden.
o Durch gedriickt halten der linken Maustaste ist es dann méglich einen
Markierungsrahmen aufzuziehen.
o Das Driicken der [Strg]-Taste ermoglicht es, weitere Punkte immer
wieder mittels weiterem Rahmen hinzuzufiigen.
o Durch Gedrtckt halten der [Shift]-Taste konnen Punkte im selben Prinzip
auch wieder abgewdhlt werden.
o Um die richtigen Punkte markieren zu kénnen, muss die Punktwolke
stetig gedreht und verschoben werden. Dies erfordert ein wenig Ubung.
Sind nur die gewiinschten Punkte markiert, konnen Sie diese 16schen.
o Hierzu bedienen Sie sich der Schaltflache ,delete current set of
vertices".
Sobald alle unerwiinschten Punkte geloscht wurden, kann die bereinigte
Punktwolke als neue Datei abgespeichert werden. Hierzu wahlen Sie in der Tab-
Leiste ,File = Export Mesh as“. Die neue Punktwolke sollte einen Hinweis
enthalten, dass es sich um die bereinigte Version handelt z.B. Modell_clean.ply.

2.5. Konvertierung der dichten Punktwolke in ein Gitter

Nun muss zwischen den Punkten der dichten Punktwolke ein Gitter generiert
werden. Hierzu wird die Funktion ,,Surface Reconstruction Poisson“
verwendet.

Uber ,Filters > Point Set = Surface Reconstruction Poisson“ wird der
Prozess gestartet.

Im neu erschienenen Einstellungsfenster fiir ,Surface Reconstruction Poisson®
konnen Sie unterschiedliche Werte fiir die Gittererzeugung wahlen.

TArchIT empfiehlt hier: Octree depth: 12; Solver Divide: 10, Samples per node:
1; surface offsetting: 1.

11
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Sobald die Werte eingetragen wurden, wird der Prozess iiber ,apply“ gestartet.

o Dieser Prozess benotigt Rechenzeit!

Sobald der Prozess vollendet wurde, erscheint das neue Gitter im
Modellfenster und in der Layer-Anzeige.
Nun koénnen Sie entweder die dichten Punkte l6schen oder ausblenden.
o Uber das Augensymbol (links neben dem Layernamen) in der Layer-
Anzeige kann ein Layer an- und ausgeschalten werden.
o Rechts neben dem Layernamen konnen verschiedene Ansichten
ausgewahlt werden (z.B. Gitter, Gitter mit Fiillung etc.).

o Der zu bearbeitende Layer muss stets in der Layer-Anzeige ausgewdhlt sein.

Ahnlich wie die neue Punktwolke, speichern Sie auch das neue Gitter tiber , File

- Export Mesh as“ als neuen Zwischenschritt.

Auch das MeshLab-Projekt sollte spatestens jetzt gespeichert werden: ,File 2
Project”.

Genau wie in Kapitel 2.4. konnen Sie das Gitter erneut bereinigen. Es ist
wichtig, die Punktwolkenansicht des Gitters zu wihlen, da sonst keine
Punkte zur Bearbeitung bzw. zum L6schen ausgewihlt werden kénnen.

2.6. Bereinigung des Gitter (Non-Manifold Edges)

bt v1.34BETA - [S:/A nen/t wi

. . « Filters Render View Windows Tools Help
Das Gitter muss noch ,gesdubert BT
Show current filter script
werden, bevor Sie die Textur :
Cleaning and Repairing »
A Create New Mesh Layer ¥ X Delete Selected Faces Del
a'l'lflegell konnen- Remeshing, Simplification and Reconstruction * ¥ Delete Selected Faces and Vertices Shift+Del
i ) B . Polygenal and Quad Mesh » 3¢ Delete Selected Vertices Ctrl+Del
Hierzu muss das Gitter in ein P s
Smoothing, Fairing and Deformation 3
- - - Quality Measure and Computations. »
Manifold-Mesh iiberfiihrt werden ; o
Mesh Layer L Select All w
(alle Non-Mainfold-Edges miissen | e (G
ange Map Select Faces by Color
. Point Set » Sel
geloscht werden) v ‘
Texture D Sel edges longer than., y
Camera b Select None i

Deshalb wahlen Sie tiber , Filters =
Selection 2 select non-manifold

Select Redundant Faces

Select Self Intersecting Faces

Select by Foce Quality
Select by Vertex Quality
Select non Manifold Edges

edges” und bestatigen dies im neuen
Fenster tiber ,apply“. Sobald der

Select non Manifold Vertices

Small component selection

Prozess abgeschlossen ist, konnen Sie
das Fenster liber ,close” schliefsen.
Nun miissen die gewahlten, gefilterten Kanten geléscht werden. Hierfiir wird
die Schaltflache , delete current set of vertices“ betatigt.

Nun sollten Sie das Gitter erneut zwischenspeichern.
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SFM - Open Source - Workshop



2.7. Parametrisierung der Textur / Export

. . . B p ization + ing f Is d ..
e Nun werden die Bildinformationen der Fotos arameterization - texturing from registered .. |

an das Gitter angepasst, um spiter in Blender [ saommetnzeoand exesty oeatng

die Textur auf das Modell auflegen zu i oS onto the setofedstered

kdonnen. Texture size 4038 |
e Hierzu ist das Werkzeug , Filters - texture 2> Texture name |Bespiel_texture.ngl |

parameterization + texturing from registered Calor correction

Color correction filter | 1 |

rasters” zu wahlen. Die Einstellung sollte so _ _
Use distance weight

angepasst werden, dass sie mit den Werten der Use image border weight

nebenstehenden Abbildung ibereinstimmen [ use image alpha weight
Clean isolated triangles

e Dann mit ,apply” bestitigen.
pply 8 UV stretching

e Nun sind alle Vorbereitungen fiir die

Texture gutter 4
Weiterverarbeitung mit Blender abgeschlossen. . |
Default Help
e Das fertige Gitter sollte jetzt iiber , File > . —
ose pply

Export Mesh as“ (z.B.) als *.obj-Datei
exportiert werden.
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2.8. Zusammenfassung Workflow MeshLab

(1) MeshLab starten.
(2) VisualSFM-Projektdaten laden (Schaltflache II oder iiber ,File > Open project”).
o zundchst die Datei: ,bundle.rd.out” auswihlen.
o dann die Datei ,list“ auswihlen.
o Warten bis die Punktwolke geladen ist.
(3) Dinne Punkte in der Layer-Anzeige markieren und léschen.
(4) Dichte Punktwolke einladen (Uber Schaltfliche III oder File © Import mesh).
o Warten bis die Punktwolke geladen ist.

(5) Punktwolke bereinigen.

Punkte markieren ok ED:I x Punkte 16schen

o Speichern
(6) ,Surface Reconstruction Poisson“ durchfiihren.
o Filters = Point Set = Surface Reconstruction Poisson (12/10/1/1)
o Speichern
(7) Bereinigung des neuen Gitters (siehe Punkt 5).
(8) Bereinigung des Gitters (Non-Manifold Edges).
o ,Filters = Selection = select non-manifold edges*.
(9) Textur berechnen.
o ,Filters - texture = parameterization + texturing from registered rasters”.

(10) Das fertige Gitter iiber ,File > Export Mesh as” als *.obj-Datei exportieren.

14
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Kapitel 3: Erste Schritte in Blender

3.1. Installation und Allgemeines

e Blender konnen Sie iiber https://www.blender.org/beziehen.

e Nach der Installation kann Blender gestartet werden. Ein Verkniipfungssymbol
sollte bereits automatisch auf den Desktop angelegt worden sein.

e Die Aufgabe von Blender ist es, das Gitter aus MeshLab mit Textur zu versehen und
aus dem 3D-Modell ein anschauliches Video zu generieren.

Blender ist ein sehr komplexes Programm und bietet erstaunlich viele
Anwendungsmdglichkeiten und Funktionen.

3.2. Uberblick Programmoberfliche Blender

B
%
&

glg E!g E!E Eg
28} CFb) MoEE) G5

N
2
2

|
F
\

"B ii
EINS F I [

1) Tool-Shelf: Werkzeuge.

2) Properties-Shelf: Eigenschaften von Objekten dndern (Position, Grofde, Rotation
u.v.m.).

3) Outliner: Alle Elemente im Projekt, "Inhaltsverzeichnis".

4) Properties-Fenster: Zugriff auf Einstellungen fiir Beleuchtung, Kamera,
Oberflachenbeschaffenheit und andere Detaileigenschaften.

5) Zeitleiste: Ablauf der Animation.

6) 3D-Fenster: Arbeitsbereich.

c = ATArchl’
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3.3. Grundlegendes

Navigation

o Zoom: Mausrad

o Links/Rechts: [STRG]+Mausrad

o Hoch/Runter: [Shift]+Mausrad

o frei bewegen: Mausrad driicken und Maus bewegen

Ansichten

o 4-Fenster-Ansicht déffnen/schliefsen: [STRG]+[ALT]+[Q]

o Definierte Ansichten, Vorne/Rechts/Oben/Unten: [Num 1/3/7/9]

o Gesamte Szene anzeigen: [Pos 1]

Auswdhlen

o Objekte auswdhlen: rechte Maustaste, mit [Shift] mehre Auswdhlen oder einzelne
abwdhlen

Kamera

o [Strg]+[Alt] + [0] setzt die Kamera auf die aktuelle Blickposition

o [Num 0] Kamerasicht ein / aus

Modellberechnung

o [F12] Render-Vorschau/Modus

Flr die Steuerung und Navigation in Blender ist die Verwendung unterschiedlicher
Tastaturkiirzel unumganglich. Es empfiehlt sich, die wichtigsten Tastaturkiirzel anhand
einer einfachen Szene durchzuexerzieren. Eine Auflistung der wichtigsten Shortcuts
(bezogen auf das Tutorial) ist dem Script beigelegt (Anhang).

3.4. Textur auflegen

Blender starten.
[Entf] + [Enter]: entfernt den Standardwiirfel.
Import der SFM-Datei..

o Unter ,File - Import“. Dateiformat *.obj wadhlen und dann den
Speicherort des aus MeshLab exportieren Gitters auf der Festplatte
auswahlen.

o Warten bis das Gitter geladen ist.

Modell/Gitter mit der rechten Maustaste auswahlen.

Fotos als Oberfldchenmaterial

i
.‘%

Im Properties-Fenster (4) auf die Textur-Schaltflache klicken (Schachbrett)
und im Meniibereich darunter das Runde-Schachbrettsymbol auswahlen.

16
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¢ Im Image-Tab-Bereich (NICHT SOURCE) auf, Open (Ordner-Symbol)“ klicken.

K texture.png EE

RN

o Jetzt laden Sie die zu dem Gitter dazugehorige PNG-Datei, die MeshLab in
Punkt 2.7 erstellt hat.

o Diese Datei heifst ,texture.png“ und befindet sich in Beispiel.nvm.cmvs\
00\models\.

o Diese Datei muss ausgewahlt werden.

Schachbrett).

e In der Haupt-Tab-Leiste (4) gehen Sie nun auf Material (Kugel, links neben
N :Jl'

e Im Material-Bereich unter Shading den Haken bei shadeless setzen.

e [F12] 6ffnet den ,Render-Modus” und zeigt das Ergebnis, [ESC] schliefd3t ihn
wieder.

3.5. Animation ,Rundflug”

e Das Objekt muss ggf. noch im korrekt im Raum platziert werden:

®)
@)
©)

4-er-Fenster aktivieren: [STRG]+[ALT]+[Q].

Objekt markieren (rechte Maustaste).

Oberhalb der Zeitleiste (5), links der Schaltfliche ,,Global“ den blauen
Bogen anwahlen und im 3D-Fenster durch klicken mit der linken
Maustaste auf die Achsen des Drehkreuzes das Objekt rotieren.

A

Ik i Global %

Dann wieder oberhalb der Zeitleiste (5) auf den Pfeil klicken und das Objekt
in den Raumesrichtungen verschieben.
L Global ¥

e Pfad hinzufiligen:

@)
©)

Oberhalb der Zeitleiste (5): ,Add > Curve > Circle".

Am blauen Pfeil mit linker Maustaste nach oben auf die Hohe, auf der
spater die Kamera kreisen soll, ziehen.

Mit dem Cursor in die Mitte des Kreises zielen und [S] driicken, dann Maus
bewegen, bis der Kreis etwas grofler als die gesamte Szene ist. Mit
linker Maustaste abschliefden.

17
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e Kamera einstellen

O

o O O O

@)
®)

Kamera markieren.

mit den oben beschrieben Methoden in die Nahe des Kreises schieben
(linke Maustaste auf die Koordinatenachsen).

Dann [Shift]+ rechte Maustaste auf den Kreis.

[STRG]+[P] = ,Follow path“ auswihlen — Kamera folgt dem Kreispfad.
Kamera auswahlen und mit [Shift] zusédtzlich das Objekt markieren.
[STRG]+[T] >“Track to Constraint“ auswihlen — Kamera fokussiert
immer automatisch Zielobjekt.

[ALT]+[A] startet die Kamerafahrt (die ,Animation®), stoppen mit [ESC].
[Num 0] schaltet die Kamerasicht ein/aus. Jetzt nochmal die Animation
starten.

Ggf. muss der Fokuspunkt der Kamera gedandert werden.
= Dazu das 3D-Objekt markieren.
= mit [N] das Properties-Shelf 6ffnen.
= unter 3D-Cursor den 3D-Cursor auf die Stelle setzten, auf die die
Kamera fokussieren soll.
* Dann im Tool-Shelf unter ,Tools” auf ,Set-Origin“ klicken und
,0rigin to 3D-Cursor” wahlen.
* Der Kamerafokus sollte sich jetzt geindert haben.
Kamera nun so positionieren, dass das gesamte Objekt sichtbar ist.
Ggf. weitere Schritte um den Kameraausschnitt dem Objekt anzupassen:
= [Num O] + [Shift + F] um die Kameraansicht zu verandern
= Danach: Mausrad fiir Zoom; W/ A/ S/ D fir vor/ links/ zurtick/
rechts

e Geschwindigkeit der Kamera regulieren

@)
@)
©)

Kreis markieren.

im Properties-Fenster das Kurven-Symbol markieren.

unter ,Path Animation“ die Frame-Anzahl erhoéhen, um die
Geschwindigkeit zu verringern und umgekehrt.

3.6. Animation: Beleuchtung

o

Lampe markieren und im Properties-Fenster auf das Lampensymbol
klicken.

Hier konnen verschiedene Lampenarten gewidhlt werden. Hemi leuchtet
dabei die komplette Szene ohne Schatten aus.

Um den Effekt zu sehen, sollte man oberhalb der Zeitleiste, rechts der
Schaltflache ,Object Mode“ auf das Kreissymbol klicken und ,Texture“
wahlen.

Die Lampe kann anschlief}end wie die anderen Objekte transformiert

18
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o

werden (verschieben, Rotieren, skalieren), um den Schattenwurf zu
kontrollieren.

mit [LEERTASTE] und dem Befehl ,Add Lamp“ konnen weiter Lampen
hinzugefiigt werden.

3.7. Animation: Videoexport

e Video exportieren

@)
©)

Im Properties-Fenster auf die Kamera klicken

Unter ,Output ein Verzeichnis und einen Namen wahlen und als
Dateiformat ein Videoformat wahlen, z. B. AVI JPEG

Dann im oberen Bereich auf ,Animation“ klicken und warten bis der
Prozess durchgelaufen ist (Je nach Modell, Linge der Animation,
Auflésung, der Hardware etc. kann dieser Prozess einige Zeit benétigen)
Unter dem oben angegebenem Pfad sollte nun eine Videodatei zu finden
sein, die z. B. in Prasentationen eingebunden werden kann.

Alternativ kann auch ein Bild einer bestimmten Kameraposition exportiert
werden. Dazu beim Dateityp ein Bildformat wdhlen und auf Animation
klicken. Dann werden alle Frames als Bild gespeichert.

4.. Notizen
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5. Anhang 1: Blender Tastaturkiirzel

Grundlagen/ Allgemeines

Auswahlen

Mehrere Objekte auswahlen

Alles auswahlen

Rechteckige Auswahl
Kreisformige Auswahl (Mausrad fir GroRe)
Lasso Auswahl

Pan/ Scrollen

Zoom

Objekt hinzuftgen

Loschen

Suchen nach bestimmter Funktion
Datei Speichern

Rendern

Animation Rendern

Rendern stoppen

Rickgangig

Wiederherstellen

Rechte Maustaste
Shift + rechte Maustaste

A

Strg + linke Maustaste bewegen
Mittlere Maustaste halten
Mausrad

Shift + A

X oder Entf

Leertaste

Strg +S

F12

Strg + F12

Esc

Strg +Z

Strg + Shift +Z

Objekt Duplizieren Shift + D
Gruppieren (erstes aktiviertes Objekt wird Parent
) Strg + P
[Elternteil])
Gruppierung aufheben Alt+P
Tracking (Objekte aneinander ausrichten) Strg+ T
20
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Tracking aufheben

3D Cursor zuriicksetzen

Navigation und Bewegung

Objekt bewegen

Rotieren

Skalieren

Entlang der Achsen bewegen

Aufsicht

Frontansicht

Seitenansicht

und

Wechsel zwischen

perspektivischer Ansicht

orthogonaler

Kameraansicht
Kameraansicht andern (,,Fly Mode®)

Kameraansicht bewegen

Kameraansicht zoomen

Kamera auf die aktuelle Blickposition

Animation

Keyframe einfliigen (davor Objekt auswahlen!)
Keyframe entfernen

Zwischen Keyframe hin und her bewegen

Alt+T

Shift + C

X/Y/Z

Nummernblock 7
Nummernblock 1
Nummernblock 3

Nummernblock 5

Nummernblock O
Shift + F

Shift + F danach mit W /A /S / D fur hin / links /
rechts / weg

Shift + F danach mit Mausrad

Strg + Alt+0

Alt + 1

Strg + Pfeil nach oben/ unten

Animation abspielen Alt + A
Animation rickwarts abspielen Alt + Shift + A
21
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